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摘要 

我們在校園的花圃中發現蜘蛛的共織網，而且共織網上的蜘蛛通常是肩斑

銀腹蛛，所以我們決定做一張模擬肩斑銀腹蛛的網，並另做仿生獵物，射向單

個與多個仿肩斑銀腹蛛的平面網，最後進行比對。從實驗中，我們發現力道對

仿生網的晃動幅度無太大的影響，仿生獵物的質量則會影響。在多個平面網的

實驗當中，我們將仿生獵物射在第一個平面網，第二個連接著第一個網，但沒

有直接接觸仿生獵物。而我們分析完數據後，發現第一個網的震動幅度大於第

二個網。 

壹、 前言 

一、 研究動機： 

我們在校園中發現一張同時存在許多隻蜘蛛的多個平面網，也就是蜘

蛛的共織網，並且發現在共織網上的蜘蛛數量比單個蜘蛛網來得多。去清

境農場校外教學時，在路邊的路燈和樹木上發現許多蜘蛛的共織網，共織

網的長度長達兩、三公尺，且上面的落網獵物比其他單個蜘蛛網的來得多，

我們覺得蜘蛛的共織網很有趣，因此想進一步的探討蜘蛛的共織網。 

二、 目的： 

（一） 探討校園內的蜘蛛的體長與社會性行為 

（二） 探討不同位置射入獵物，造成單個仿生平面網的震動關係。 

（三） 探討不同力道射入的獵物，造成單個仿生平面網的震動關係。 

（四） 探討不同大小的獵物，造成單個仿生平面網的震動關係。 

（五） 探討不同力道射入的獵物，造成多個仿生平面網的震動關係。 

（六） 探討不同大小的仿生獵物，造成多個仿生平面網的震動關係。 

（七） 分析單個平面網的震動幅度與多個平面網的震動幅度之關係。 

 

 

 

 

 

 

 

 

 

 

 

 

 圖 1-1 實驗架構圖 
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三、 文獻探討： 

（一） 文獻探討： 

1. 蜘蛛的社會性行為： 

S. longus 和 S. celarius 成蟲有效地保護了它們的大型巢穴免受潛在

捕食者的侵害，巢穴防禦的效果隨著巢穴中個體數量的增加而增加。

S. takahashii 和 S. saharai 顯示沒有反擊效果。反擊能力隨著成年密度的

增加而增加，因此社交性可能會彌補較大巢穴的脆弱性。(Kataro, 2004)。

另一篇文獻溫度調節蜘蛛個體攻擊性、活動水平和社會行為的變化發

現蜘蛛 Anelosimus studiosus 的社會性行為通過共享的遺傳基礎（例如

代謝差異）聯繫在一起並且響應當代非生物環境（即溫度）而非獨立

地轉變的假設是一致的。此外，其數據表明，溫度本身可能是造成 A. 

studiosus 社會結構中人口間差異的原因。(Jonathan, 2011) 。 

下一篇跟蜘蛛的社會性行為有關的文獻中，他們研究了獵物可用性

如何影響社交蜘蛛 Stegodyphus sarasinorum, Karsch, 1892 (Eresidae) 中

的網和網狀絲的數量。在實驗室設置中，我們觀察到與餵食的蜘蛛相

比，未餵食的蜘蛛在織網方面的投資更多。未餵食的社會蜘蛛群落比

餵食的群落產的絲更多，尤其是沙蠶絲(Saroja, 2021)。在最後一篇的蜘

蛛社會性的文獻中，他們測試了社交蜘蛛網中存在的優勢細菌是否因

採樣地點而異，以及更永久的撤退網是否含有與沙漠社交蜘蛛

Stegodyphus dumicola 中更短暫的捕獲網在成分上不同的微生物. 他們

還對一部分菌落中的蜘蛛角質層和獵物進行了採樣(carl, 2019) 。 

2. 蜘蛛的仿生網： 

第一篇仿生網的文獻中，是以蜘蛛捕食為靈感研究動力學，設計了

一種新型仿生空間碎片清除裝置，該裝置由柔性網、中心輪轂、牽引

質量和旋轉機構組成。首先，詳細介紹了仿生空間碎片清除的概念和

相應的系統設計。其次，分別推導和製定了自旋展開和碰撞的動力學

模型。第三，提出了一種有限元分析來模擬紡絲網展開過程的動態特

性(Boting Xu, 2019)。第二篇是探究人工蜘蛛網為了研究人造蜘蛛網的

振動傳遞特性，利用高速攝影系統記錄和分析振動圖像，並利用峰峰

值表徵振動強度。此外，分別在完整和破壞條件下研究了人造蜘蛛網

的振動性能。他們的測試觀察揭示了蜘蛛網獨特結構的振動傳遞規律

(Jun Wang, 2019)。 

後一篇蜘蛛網的能量吸收，他們從力學的角度研究了蜘蛛網的能量

耗散機制。首先，對單根蜘蛛絲在橫向衝擊下的動態響應和能量耗散

進行了解析和數值研究。動態響應曲線的一致性驗證了有限元分析的

準確性。然後使用有限元方法對整個網絡進行建模，並獲得模擬獵物

撞擊過程中每條路線對總能量耗散的各自貢獻，這與已發表的實驗結
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果一致。最後，基於有限元模型論證了初始衝擊動能對 3 條路徑分數

分佈的影響 (Hui Yu, 2015)。 

 

3. 肩斑銀腹蛛： 

肩斑銀腹蛛，為肖峭科銀鱗蛛屬的動物。分布於日本、朝鮮、台

灣以及中國大陸的山東、湖南、湖北、江蘇、安徽、廣東、四川、

西藏、河南、陝西等地，常見於農田、果園、茶園。該物種的模式

產地在日本。在這一篇文獻中，報告台灣產銀腹蛛屬蜘蛛 9 種，其

中新種有台灣銀腹蛛(Leucauge taiwanensis sp. nov. )；新紀錄種有 4

種：西里伯銀腹蛛(L. celebesiana)、十字銀腹蛛(L. crucinota)、小肩斑

銀腹蛛(L. subblanda)、武陵銀腹蛛(L. wulingensis)。 

文中將大銀腹蛛(L. magnifica)處理為西里伯銀腹蛛的同物異名；擬

方格銀腹蛛(L. subtessellata)處理為方格銀腹蛛(L. tessellata)的同物異

名。脈斑銀腹蛛(L. venusta)，處理為排除種。並以 19 種銀腹蛛亞科

類群為內群，長腳蛛屬為外群，以 45 個形態特徵進行銀腹蛛屬的支

序分析，台灣產銀腹蛛屬可分為兩個亞群，其中十字銀腹蛛與雪銀

腹蛛(L. argentina)成為一單系群，可能屬於未知的新屬，而隨蛛屬

(Opadometa)蜘蛛與其餘的台灣產銀腹蛛屬蜘蛛被歸入另一個亞群，

其姊妹群為天星蛛屬(Mesida)(劉錫軒, 2008)。 

 

（二） 研究物種：肩斑銀腹蛛(Leucauge blanda) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

界 動物界

Animalia 

分布：以低海拔

山區。 

 

圖 1-2 肩斑銀腹蛛 

門 節肢動物門

Arthropoda 

網形：圓網 

綱 蛛形綱

Arachnida 

體長： 

雌 8-13mm 

雄 6-10mm 

目 蜘蛛目 Araneae  

外觀：近似大銀腹蛛但本種體型較小，腹背

基部有 2 枚黑色斑點，中央有 3 條縱紋於前

端處相連，末端較粗有 3 對黑色斑點，中央

有八字斑排列，雄蛛體型瘦小，體背橙褐色，

腹端具黑色斑。 

科 長腳蛛科 

Tetragnathidae 

屬 銀腹蛛屬 

Leucauge 

種 肩斑銀腹蛛

Leucauge blanda 
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貳、 實驗器材與設備 

一、 軟體：Tracker、Excel、Tinkercad、ImageJ 

二、 器材：瓦楞板、釣魚線、美工刀、剪刀膠帶、輕黏土、熱熔膠、木板、木條、        

簽字筆 

三、 設備：熱熔膠槍、手機、電腦 

 

 

參、 研究過程及方法 

一、觀察校內花圃內各種蜘蛛的網： 

（一） 拍攝蜘蛛 

1. 尋找花圃內的蜘蛛（圖 3-1-1） 

2. 將找到的蜘蛛拍攝下來，並放入尺規（圖 3-1-2） 

3. 用 ImageJ 分析 

 

 

 

 

 

 

                   

 

 

（二） ImageJ 使用方法 

我們使用 ImageJ 了解各種蜘蛛的體長以及同種蜘蛛與不同種蜘蛛之

間的距離。 

1. File->Open，開啟要分析的圖片。（圖 3-1-3） 

2. 按第五個圖案，拉取直線。（圖 3-1-4） 

3. 拉取照片中尺規 1cm 的長度。（圖 3-1-5） 

4. 按 Analyze->Set Scale（圖 3-1-6），設定步驟 3.拉的長度為基準。

（圖 3-1-7） 

5. 使用步驟 2.的直線，拉取蜘蛛的體長（不包含腳的長度）。 

（圖 3-1-8） 

6. 按 Analyze->Measure，在最右邊的 Length，即是蜘蛛的實際長度。

（圖 3-1-9） 

7. 測量完兩隻蜘蛛的體長後，測量牠們間的最短距離（圖 3-1-10） 

圖 3-1-2 放入尺規  

數字部分單位為 cm 

圖 3-1-1 花圃蜘蛛 
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圖 3-1-3  

 

 

 

 

圖 3-1-4 

 

 

 

 

圖 3-1-5 

 

 

 

 

圖 3-1-6 

 

 

 

 

圖 3-1-7 

 

 

 

 

圖 3-1-8 

 

 

 

 

圖 3-1-9 

 

 

 

 

圖 3-1-10 

 

二、自製仿生網發射器 

（一） 第一代發射器： 

第一代發射器的主體使用瓦楞板作為模型。 

1. 按照設計圖（圖 3-2-1）繪製瓦楞板零件，並用剪刀將零件剪下 

2. 用熱熔膠將零件組裝起來（圖 3-2-2） 

3. 把橡皮筋綁在發射器的兩側，當作彈簧裝置（圖 3-2-3） 

4. 在發射器的底板上分別畫上 1cm、2cm、3cm、4cm 的拉伸長度當

做力道大小。（圖 3-2-4） 

 

 

 

 

 

 

 

 

圖 3-2-1 設計圖 

 

 

 

 

 

 

 

圖 3-2-2 第一代發射器 
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圖 3-2-3 彈簧裝置 

 

 

 

 

 

 

 

圖 3-2-4 力道刻度 

 

 

（二） 第二代發射器：  

第二代發射器的主體使用較堅固的木板作為主體。 

1. 將第一代的設計圖畫進 Tinkercad 並加上卡榫（圖 3-2-5） 

2. 用雷射切割零件，並用熱熔膠將零件黏緊。（圖 3-2-6） 

3. 在發射器的底板上分別畫上 1cm、2cm、3cm、4cm 的拉伸長度當

做力道大小。（圖 3-2-7） 

4. 第二代發射器的彈簧裝置依然是橡皮筋，但固定橡皮筋的裝置從

第一代的珠針，變成比較牢固的迴紋針。（圖 3-2-8） 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

圖 3-2-5 設計圖 圖 3-2-6 完成圖 

圖 3-2-7 力度大小 圖 3-2-8 迴紋針固定 
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三、製作仿生蜘蛛網： 

（一） 第一代仿生網： 

我們使用釣魚線模擬肩斑銀腹蛛的網，共五層。 

1. 用四條 25 公分的木條圍成一個正方形框架固定蜘蛛網 

2. 在木條內黏瓦楞板 

3. 在框架上用熱熔膠黏上四條牽引絲。我們從中心將釣魚線開始往

外繞。網上的彩色紙片是測量震動的基準點。（圖 3-3-1、2） 

 

 

 

 

 

 

 

 

                

 

（二） 第二代仿生網： 

1. 單個仿生網 

仿生蜘蛛網的構造，參考了實際觀察的肩斑銀腹蛛網，我們發現

1 公分內有 4 圈。但因我們無法做到那麼細膩，所以改成 1 公分 2

圈，而我們的仿生網半徑是 8 公分，也就是有 16 層。 

（1） 用木條圍成 25*25 正方形框架 

（2） 在木條內黏瓦楞板 

（3） 在框架上用熱熔膠黏上八條牽引絲 

（4） 從中心將釣魚線開始往外繞 

（5） 黏上 17 個彩色紙片，當作測量震動的基準點。 

（圖 3-3-3、4） 

（6） 放入 Tracker 分析震動幅度 

 

 

 

 

 

 

 

 

                 圖 3-3-3 單網設計圖 圖 3-3-4 一個仿生網 

圖 3-3-1 設計圖 圖 3-3-2 第一代仿生網 
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2. 兩個仿生網 

將兩個半徑 8 公分單一仿生網連在一起，並把第一個網最右邊的

牽引絲，連接到第二個網最左邊的牽引絲。 

（1） 用木條圍成 25*25 兩個正方形框架，繞釣魚線 

（2） 把第一個網最右邊的牽引絲，連接到第二個網最左邊的牽

引絲。（圖 3-3-5、6） 

（3） 黏上 10 個彩色紙片，當作測量震動的基準點。 

 

 

 

 

 

 

 

 

 

 

 

四、仿生網震動實驗： 

（一） 實驗裝置 

1. 支架：固定發射器， 

（1） 繪製 3*4 個 4.5cm 有卡榫的正方形，以及 3*4 個 3*12.3cm 

的長方形於 Tinkercad（圖 3-4-1） 

（2） 雷射切割木板，並用熱熔膠黏緊（圖 3-4-2） 

 

 

 

 

 

 

 

 

 

2. 手機架： 

（1） 切割 28*10 的長方形瓦楞板，並將其摺對半（圖 3-4-3） 

（2） 在長方形瓦楞板上剪兩個 2cm 的凹槽（圖 3-4-4） 

（3） 黏在桌子上固定 

圖 3-4-1 設計圖 圖 3-4-2 不同位置的三個支架 

圖 3-3-5 雙網設計圖 圖 3-3-6 兩個仿生網 
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（二） 操縱變因 

1. 操縱變因 1：不同位置 

我們分別射到網中央、網左側邊緣處、和網右側邊緣處 

 

0 

 

 

 

 

 

 

 

2. 操縱變因 2：不同獵物大小 

我們使用輕黏土製作仿生獵物，並以重量大小為變因。 

 

 

 

 

 

 

 

 

 

 

3. 操縱變因 3：不同力道射入 

我們依據橡皮筋拉長的長度在發射器的底板畫上刻度，並以力度

大小作為變因。 

 

 

 

 

圖 3-4-8 獵物重量 獵物重量為 0.1g、0.2g、0.4g、0.8g

其為公比=2 的等比數列 

圖 3-4-5 左側邊緣處 圖 3-4-6 網中央 圖 3-4-7 右側邊緣處 

圖 3-4-9 長度刻度  

力道大小為拉長 1cm、2cm、3cm、4cm 

圖 3-4-3 對摺瓦楞板 圖 3-4-4 剪凹槽 
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（三） Tracker 分析方式 

我們使用 Tracker 測試仿生網的震動。 

1. 檔案->開啟，開啟將要分析的實驗影片。（圖 3-4-10） 

2. 按軸線，定位直角坐標。（圖 3-4-11） 

3. 將軸線與仿生網的木條對齊。（圖 3-4-12） 

4. 新增->測量工具->量尺測量，測量影片與真實長度的比例尺。 

（圖 3-4-13） 

5. 用量尺拉出影片中 1cm 的刻度，作為比例尺（圖 3-4-14） 

6. 新增->質點，新增測量晃動震度的質點。（圖 3-4-15） 

7. 質點->自動追蹤軌跡，可自動追蹤質點的晃動情形。（圖 3-4-16） 

8. 按搜尋，它就會靠顏色辨識來追蹤。（圖 3-4-17） 

 

 

 

 

 

圖 3-4-10 開啟檔案 

 

 

 

 

圖 3-4-11 軸線 

 

 

 

 

 

 

圖 3-4-12 軸線與木條對齊 

 

 

 

 

 

 

圖 3-4-13 開啟量尺 

 

 

 

 

圖 3-4-14 設定比例尺 

 

 

 

 

圖 3-4-15 新增質點 

 

 

 

 

 

 

 

圖 3-4-16 自動追蹤軌跡 

 

 

 

 

 

 

 

圖 3-4-17 自動追蹤質點 
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（四）Excel 操作方式 

我們將分析好的 Tracker 放到 Excel 做成圖表。 

1. 將質量 A 的 0.8g 4cm 左、中、右表格資料貼到 Excel 工作表 1；

將質量 B 的 0.8g 4cm 左、中、右貼到工作表 2……依此類推。

（圖 3-4-17） 

2. 將 X 軸的數據除以比例尺。（圖 3-4-18） 

3. 將前一個數據減掉下一個數據，即可得知它的震動幅度。 

（圖 3-4-19） 

4. 把要比較的數據做成折線圖。（圖 3-4-20） 

5. x 座標軸標題改為「影格（個）」；y 座標軸標題改為「震動幅度

（公分）」。（圖 3-4-21） 

6. 標出每組數據的最高值。（圖 3-4-22） 

7. 由大到小排列，進行比較。 

  

  

  

圖 3-4-17 把數據貼到 Excel 圖 3-4-18 除以比例尺 

圖 3-4-19 算出震動幅度 圖 3-4-20 插入折線圖 

圖 3-4-21 改座標軸標題 圖 3-4-22 標記最高值 
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肆、 研究結果 

一、 探討校園內的蜘蛛的體長與社會性行為： 

 

 

 

 

 

 

 

 

 

 

圖 4-1-1 

圖 4-1-1 是肩斑銀腹蛛與鬼蛛的共織網，偏右

邊在葉子背面的蜘蛛是肩斑銀腹蛛，體長大約

4.3mm；左邊在芒草葉子上的是鬼蛛，體長約略

5.5mm。這兩隻蜘蛛是在同一張網，雖然他沒有

完整的網型，但他們是共用蜘蛛絲。這兩隻蜘

蛛之間，兩隻蜘蛛的距離大約是 2 公分。 

 

 

 

 

 

 

 

 

 

 

圖 4-1-2 

圖 4-1-2 肩斑銀腹蛛的網，中間空心的直徑大

約 2.4 公分，在網的中心的蜘蛛是網的主人肩

斑銀腹蛛，體長約為 6.5mm；而在這張網子邊

緣的蜘蛛則是鬼蛛，這兩隻蜘蛛之間的距離約

6 公分。這張網的形狀完整度很高，構建於植

物之間，支撐這張網的牽引絲連接在葉緣。 

 

 

 

 

 

 

 

 

 

圖 4-1-3 

圖 4-1-3 尺規上方的蜘蛛是肩斑銀腹蛛，體長

約 3.2mm，尺規左下方的是三角鬼蛛，體長大

約 6.8mm。這不算是共織網，他只是共用牽引

絲，沒有共同編織一張網。 

兩者的距離大約是 5.3 公分。 
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圖 4-1-4 

圖 4-1-4 的蜘蛛共織網，它與前面圖四、圖二

不同，它是由兩個獨立的平面網，以牽引絲

相互連接，所以這兩隻肩斑銀腹蛛都有各自

獨立的蜘蛛網，只是他們有牽引絲可以自由

移動。第一隻肩斑銀腹蛛在右上角，這隻蜘

蛛的體長有大約 3.5mm；另一隻蜘蛛則是在

尺規的正上方，體長約為 3.9mm。這兩隻肩

斑銀腹蛛之間的直線距離（不是牽引絲的距

離）是 7.2 公分。 

 

 

 

 

 

 

 

 

 

圖 4-1-5 

圖 4-1-5 裡的蜘蛛雖然不是我們研究主題的肩

斑銀腹蛛，但他仍然可算是蜘蛛的社會性行

為。這兩隻蜘蛛是簷下姬鬼蛛的共織網，這

兩隻是在同一張完整的蜘蛛網，所以他們是

共同織一張網。右邊的簷下姬鬼蛛體長大約

3.9mm；左邊那隻簷下姬鬼蛛是 3.7mm。 

 

 

 

 

 

 

 

 

 

圖 4-1-6 

圖 4-1-6 中的是兩隻熱帶塵蛛的共織網，這兩

隻塵蛛是共同編織一張網，所以他其實是一

張平面網上，同時存在著兩隻塵蛛。左邊的

這隻塵蛛的位置是在這個的網的中心，他的

體長大約 3.5mm；在左邊的那隻則是在網邊

緣的牽引絲上，其體長約為 3.1mm。這兩隻

熱帶塵蛛的距離約為 2.7 公分。 

 

 

 

 

 

 

 

 

圖 4-1-7 

圖 4-1-7 中的共織網，其實只是這兩隻蜘蛛共

用的牽引絲，他們並沒有共同織一個完整的

網。他們的共同牽引絲就連接在兩株尚未開

花的植物上。左邊那隻在花苞上的是塵蛛，

體長約 6.6mm；右邊在牽引絲上的蜘蛛是肩

斑銀腹蛛，體長大約 7.8mm。這兩隻蜘蛛的

距離 5.5 公分。 
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二、 獵物射入的位置與單個仿生平面網震動的關係： 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

表 4-1 蜘蛛體長與兩者間的距離 數字部分單位為 cm 

表 4-2-1 (0.8g 4cm)不同角度 

質量 A 的震動情況 

左，中，右最大振幅為 

0.14614，0.21434，0.31189  

振幅比較：右＞中＞左 

表 4-2-2 (0.8g 4cm)不同角度 

質量 B 的震動情況 

左，中，右最大振幅為：

0.07997， 0.07430，0.28882 

振幅比較：右＞左＞中 

表 4-2-3 (0.8g 4cm)不同位置 

質量 C 的震動情況 

左，中，右最大振幅為： 

0.16648，0.28167，0.06196 

振幅比較：中＞左＞右 

表 4-2-4 (0.8g 4cm)不同角度 

質量 D 的震動情況 

左，中，右最大振幅為： 

0.11194，0.22503，0.16791 

振幅比較：中＞右＞左 

表 4-2-5 (0.8g 4cm)不同角度 

質量 E 的震動情況 

左，中，右最大振幅為： 

0.03554，0.20078，0.06702 

振幅比較：中＞右＞左 
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三、 獵物射入的力道與單個仿生平面網震動的關係： 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

表 4-3-1 (0.8g)不同力道 

質量 A 的震動情況 

4cm，3cm，2cm，1cm 最大振幅為： 

0.21434，0.17169，0.22038，0.12520 

振幅比較：2cm＞4cm＞3cm＞1cm 

 

表 4-3-2  (0.8g)不同力道 

質量 B 的震動情況 

4cm，3cm，2cm，1cm 最大振幅為： 

0.07140，0.14858，0.13370，0.14258 

振幅比較：3cm＞1cm＞2cm＞4cm 

 

3cm＞1cm＞2cm＞4cm 

 

 

表 4-3-3 (0.8g)不同力道 

質量 C 的震動情況 

4cm，3cm，2cm，1cm 最大振幅為： 

0.20048，0.12473，0.28140，0.39330 

振幅比較：1cm＞2cm＞4cm＞3cm 

 

 

 

表 4-3-4 (0.8g)不同力道 

質量 D 的震動情況 

4cm，3cm，2cm，1cm 最大振幅為： 

0.22504，0.29358，0.12473，0.21720 

振幅比較：3cm＞4cm＞1cm＞2cm 

 
表 4-3-5 (0.8g)不同力道 

質量 E 的震動情況 

4cm，3cm，2cm，1cm 最大振幅為： 

0.20078，0.16030，0.14695，0.16670 

振幅比較：4cm＞1cm＞3cm＞2cm 
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四、 獵物重量與單個仿生平面網震動的關係： 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

表 4-4-1 (4cm)不同獵物重量 

質量 A 的震動情況 

0.1g，0.2g，0.4g，0.8g 最大振幅為： 

0.00684，0.10500，0.15510，0.21435 

振幅比較：0.8g＞0.4g＞0.2g＞0.1g 

 

0.8g＞0.4g＞0.2g＞0.1g 

表 4-4-2 (4cm)不同獵物重量 

質量 B 的震動情況 

0.1g，0.2g，0.4g，0.8g 最大振幅為： 

0.62587，0.11157，0.11250，0.00850 

振幅比較：0.1g＞0.2g＞0.4g＞0.8g 

 

表 4-4-3 (4cm)不同獵物重量 

質量 C 的震動情況 

0.1g，0.2g，0.4g，0.8g 最大振幅為： 

0.04113，0.22450，0.18850，0.28168 

振幅比較：0.8g＞0.2g＞0.4g＞0.1g 

表 4-4-4 (4cm)不同獵物的重量 

質量 D 的震動情況 

0.1g，0.2g，0.4g，0.8g 最大振幅為： 

0.01483，0.08979，0.15000，0.22504 

振幅比較：0.8g＞0.4g＞0.2g＞0.1g 

 
表 4-4-5 (4cm)不同獵物的重量 

質量 E 的震動情況 

0.1g，0.2g，0.4g，0.8g 最大振幅為： 

0.00820，0.06510，0.10020，0.20078 

振幅比較：0.8g＞0.4g＞0.2g＞0.1g 
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五、 獵物射入的力道與多個仿生平面網震動的關係： 

（一） 第一張網的震動狀態 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

（二） 第二張網的震動狀態 

 

 

 

 

表 4-5-1 (0.8g)不同力道的 

質量 A 的震動情況 

4cm，3cm，2cm，1cm 最大振幅為： 

0.32142，0.23389，0.12500，0.19642 

振幅比較：4cm＞3cm＞1cm＞2cm 

 

表 4-5-2 (0.8g)不同力道的 

質量 B 的震動情況 

4cm，3cm，2cm，1cm 最大振幅為： 

0.16964，0.07134，0.15178，0.18750 

振幅比較：1cm＞4cm＞2cm＞3cm 

 

表 4-5-3 (0.8g)不同力道的 

質量 C 的震動情況 

4cm，3cm，2cm，1cm 最大振幅為： 

0.45089，0.18428，0.37500，0.21875 

振幅比較：4cm＞2cm＞1cm＞3cm 

表 4-5-4 (0.8g)不同力道的 

質量 D 的震動情況 

4cm，3cm，2cm，1cm 最大振幅為： 

0.10010，0.15593，0.19642，0.11159 

振幅比較：2cm＞3cm＞1cm＞4cm 

 

表 4-5-5 (0.8g)不同力道的 

質量 E 的震動情況 

4cm，3cm，2cm，1cm 最大振幅為： 

0.12500，0.04344，0.11607，0.08495 

振幅比較：4cm＞2cm＞1cm＞3cm 

 

表 4-5-6 (0.8g)不同力道的重量 

質量 A 的震動情況 

4cm，3cm，2cm，1cm 最大振幅為： 

0.03000，0.03609，0.02112，0.02198 

振幅比較：3cm＞4cm＞1cm＞2cm 
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六、 獵物的大小與多個仿生平面網震動的關係： 

（一） 第一張網的震動狀況 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

表 4-5-7 (0.8g)不同力道的重量 

質量 B 的震動情況 

4cm，3cm，2cm，1cm 最大振幅為： 

0.03955，0.02207，0.04776，0.02579 

振幅比較：2cm＞4cm＞1cm＞3cm 

 

表 4-5-8 (0.8g)不同力道的重量 

質量 C 的震動情況 

4cm，3cm，2cm，1cm 最大振幅為： 

0.03135，0.04405，0.02028，0.03141 

振幅比較：3cm＞1cm＞4cm＞2cm 

 

表 4-5-9 (0.8g)不同力道的重量 

質量 D 的震動情況 

4cm，3cm，2cm，1cm 最大振幅為： 

0.03265，0.03296，0.03997，0.03482 

振幅比較：2cm＞1cm＞3cm＞4cm 

 

表 4-5-10 (0.8g)不同力道的重量 

質量 E 的震動情況 

4cm，3cm，2cm，1cm 最大振幅為： 

0.02889，0.03748，0.02212，0.02804 

振幅比較：3cm＞4cm＞1cm＞2cm 

 

表 4-6-1 (4cm)不同獵物的重量 

質量 A 的震動情況 

0.1g，0.2g，0.4g，0.8g 最大振幅為： 

0.03631，0.08928，0.31250，0.32142 

振幅比較：0.8g＞0.4g＞0.2g＞0.1g 

 

表 4-6-2 (4cm)不同獵物的重量 

質量 B 的震動情況 

0.1g，0.2g，0.4g，0.8g 最大振幅為： 

0.03653，0.06250，0.22321，0.25000 

振幅比較：0.8g＞0.4g＞0.2g＞0.1g 

 

表 4-6-3 (4cm)不同獵物的重量 

質量 C 的震動情況 

0.1g，0.2g，0.4g，0.8g 最大振幅為： 

0.15178，0.28571，0.28571，0.45089 

振幅比較：0.8g＞0.4g=0.2g＞0.1g 
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（二） 第二張網的震動狀況 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

七、 單個平面網的震動幅度與多個平面網的震動幅度之關係： 

（一）0.1g 4cm 

 

 

 

表 4-6-4 (4cm)不同獵物的重量 

質量 D 的震動情況 

0.1g，0.2g，0.4g，0.8g 最大振幅為： 

0.03280，0.08035，0.14285，0.10010 

振幅比較：0.4g＞0.8g＞0.2g＞0.1g 

 

表 4-6-5 (4cm)不同獵物的重量 

質量 E 的震動情況 

0.1g，0.2g，0.4g，0.8g 最大振幅為： 

0.03837，0.11607，0.06958，0.04419 

振幅比較：0.2g＞0.4g＞0.8g＞0.1g 

 

表 4-6-6 (4cm)不同獵物的重量 

質量 A 的震動情況 

0.1g，0.2g，0.4g，0.8g 最大振幅為： 

0.02203，0.02705，0.02236，0.03379 

振幅比較：0.8g＞0.2g＞0.4g＞0.1g 

 

表 4-6-7 (4cm)不同獵物的重量 

質量 B 的震動情況 

0.1g，0.2g，0.4g，0.8g 最大振幅為： 

0.02225，0.03580，0.04352，0.03955 

振幅比較：0.4g＞0.8g＞0.2g＞0.1g 

 

表 4-6-8 (4cm)不同獵物的重量 

質量 C 的震動情況 

0.1g，0.2g，0.4g，0.8g 最大振幅為： 

0.05006，0.06784，0.03010，0.03135 

振幅比較：0.2g＞0.1g＞0.8g＞0.4g 

 

表 4-6-9 (4cm)不同獵物的重量 

質量 D 的震動情況 

0.1g，0.2g，0.4g，0.8g 最大振幅為： 

0.03140，0.05766，0.02327，0.02569 

振幅比較：0.2g＞0.1g＞0.8g＞0.4g 

 
表 4-6-10 (4cm)不同獵物的重量 

質量 E 的震動情況 

0.1g，0.2g，0.4g，0.8g 最大振幅為： 

0.03066，0.04260，0.02992，0.02889 

振幅比較：0.2g＞0.1g＞0.4g＞0.8g 

 

表 4-7-1 質量 A 兩個網的震動情況 

第一個網，第二個網最大振幅為： 

0.03731，0.02235 

振幅比較：第一個網＞第二個網 
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（二）0.2g 4cm 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

表 4-7-2 質量 B 兩個網的震動情況 

第一個網，第二個網最大振幅為： 

0.03754，0.02408 

振幅比較：第一個網＞第二個網 

 

表 4-7-4 質量 D 兩個網的震動情況 

第一個網，第二個網最大振幅為： 

0.03371，0.02401 

振幅比較：第一個網＞第二個網 

表 4-7-3 質量 C 兩個網的震動情況 

第一個網，第二個網最大振幅為： 

0.15596，0.05078 

振幅比較：第一個網＞第二個網 

表 4-7-5 質量 E 兩個網的震動情況 

第一個網，第二個網最大振幅為： 

0.03942，0.03110 

振幅比較：第一個網＞第二個網 

 

表 4-7-6 質量 A 兩個網的震動情況 

第一個網，第二個網最大振幅為： 

0.10377，0.02915 

振幅比較：第一個網＞第二個網 

 

表 4-7-7 質量 B 兩個網的震動情況 

第一個網，第二個網最大振幅為： 

0.06603，0.03766 

振幅比較：第一個網＞第二個網 

 

表 4-7-8 質量 C 兩個網的震動情況 

第一個網，第二個網最大振幅為： 

0.30188，0.07136 

振幅比較：第一個網＞第二個網 
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（三）0.4g 4cm 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

表 4-7-9 質量 D 兩個網的震動情況 

第一個網，第二個網最大振幅為： 

0.15094，0.06065 

振幅比較：第一個網＞第二個網 

 

表 4-7-10 質量 E 兩個網的震動情況 

第一個網，第二個網最大振幅為： 

0.12264，0.04481 

振幅比較：第一個網＞第二個網 

 

表 4-7-11 質量 A 兩個網的震動情況 

第一個網，第二個網最大振幅為： 

0.08371，0.43526 

振幅比較：第二個網＞第一個網 

 

 

表 4-7-12 質量 B 兩個網的震動情況 

第一個網，第二個網最大振幅為： 

0.09356，0.04951 

振幅比較：第一個網＞第二個網 

 

表 4-7-13 質量 C 兩個網的震動情況 

第一個網，第二個網最大振幅為： 

0.06401，0.04846 

振幅比較：第一個網＞第二個網 

 

表 4-7-14 質量 D 兩個網的震動情況 

第一個網，第二個網最大振幅為： 

0.05909，0.02615 

振幅比較：第一個網＞第二個網 

 

表 4-7-15 質量 E 兩個網的震動情況 

第一個網，第二個網最大振幅為： 

0.10087，0.03933 

振幅比較：第一個網＞第二個網 
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（四）0.8g 4cm 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

（五）0.8g 3cm 

 

 

 

 

 

 

表 4-7-16 質量 A 兩個網的震動情況 

第一個網，第二個網最大振幅為： 

0.30927，0.03037 

振幅比較：第一個網＞第二個網 

表 4-7-17 質量 B 兩個網的震動情況 

第一個網，第二個網最大振幅為： 

0.24054，0.03555 

振幅比較：第一個網＞第二個網 

 

表 4-7-18 質量 C 兩個網的震動情況 

第一個網，第二個網最大振幅為： 

0.43384，0.02818 

振幅比較：第一個網＞第二個網 

 

表 4-7-19 質量 D 兩個網的震動情況 

第一個網，第二個網最大振幅為： 

0.09631，0.02934 

振幅比較：第一個網＞第二個網 

 

表 4-7-20 質量 E 兩個網的震動情況 

第一個網，第二個網最大振幅為： 

0.12027，0.02596 

振幅比較：第一個網＞第二個網 

 

表 4-7-21 質量 A 兩個網的震動情況 

第一個網，第二個網最大振幅為： 

0.05584，0.04029 

振幅比較：第一個網＞第二個網 
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（六）0.8g 2cm 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

表 4-7-22 質量 B 兩個網的震動情況 

第一個網，第二個網最大振幅為： 

0.06935，0.01965 

振幅比較：第一個網＞第二個網 

表 4-7-23 質量 C 兩個網的震動情況 

第一個網，第二個網最大振幅為： 

0.03896，0.02790 

振幅比較：第一個網＞第二個網 

表 4-7-24 質量 D 兩個網的震動情況 

第一個網，第二個網最大振幅為： 

0.04178，0.03412 

振幅比較：第一個網＞第二個網 

表 4-7-25 質量 E 兩個網的震動情況 

第一個網，第二個網最大振幅為： 

0.03688，0.03648 

振幅比較：第一個網＞第二個網 

表 4-7-26 質量 A 兩個網的震動情況 

第一個網，第二個網最大振幅為： 

0.01261，0.31576 

振幅比較：第一個網＞第二個網 

表 4-7-27 質量 B 兩個網的震動情況 

第一個網，第二個網最大振幅為： 

0.15315，0.04179 

振幅比較：第一個網＞第二個網 

表 4-7-28 質量 C 兩個網的震動情況 

第一個網，第二個網最大振幅為： 

0.37837，0.01779 

振幅比較：第一個網＞第二個網 
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（七）0.8g 1cm 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

表 4-7-29 質量 D 兩個網的震動情況 

第一個網，第二個網最大振幅為： 

0.19820，0.03497 

振幅比較：第一個網＞第二個網 

表 4-7-30 質量 E 兩個網的震動情況 

第一個網，第二個網最大振幅為： 

0.11711，0.01935 

振幅比較：第一個網＞第二個網 

表 4-7-31 質量 A 兩個網的震動情況 

第一個網，第二個網最大振幅為： 

0.19784，0.02113 

振幅比較：第一個網＞第二個網 

表 4-7-32 質量 B 兩個網的震動情況 

第一個網，第二個網最大振幅為： 

0.18885，0.02579 

振幅比較：第一個網＞第二個網 

表 4-7-33 質量 C 兩個網的震動情況 

第一個網，第二個網最大振幅為： 

0.22032，0.03142 

振幅比較：第一個網＞第二個網 

表 4-7-34 質量 D 兩個網的震動情況 

第一個網，第二個網最大振幅為： 

0.11239，0.03482 

振幅比較：第一個網＞第二個網 

表 4-7-35 質量 E 兩個網的震動情況 

第一個網，第二個網最大振幅為： 

0.03581，0.02804 

振幅比較：第一個網＞第二個網 
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伍、 討論 

一、 探討校園內的蜘蛛的體長與社會性行為： 

在校園觀察中，我們發現肩斑銀腹蛛的共織網大多為單獨平面網透過牽

引絲連結在一起；而其他類蜘蛛的共織網則為共同編織居多。因此我們

的模擬實驗以肩斑銀腹蛛的共織網模型為主。 

二、 探討不同位置射入獵物，造成單個仿生平面網的震動關係： 

獵物射入位置的質點，震動幅度會最大。 

三、 探討不同力道射入的獵物，造成單個仿生平面網的震動關係： 

在我們的模擬實驗中，力道對網的震動幅度影響不顯著。因此我們推測

獵物的速度不會影響網的震動。所以在我們未來的實驗中，將會把力道

當作控制變因。 

四、 探討不同大小的獵物，造成單個仿生平面網的震動關係： 

獵物重量越大，影響網的震動越明顯。 

五、 探討不同力道射入的獵物，造成多個仿生平面網的震動關係： 

蜘蛛網震動時，蜘蛛會有護食的現象，所以我們猜測當獵物射到其中一

個網時，另一個網上的蜘蛛會尋找獵物在何處。 

六、 探討不同大小的仿生獵物，造成多個仿生平面網的震動關係： 

獵物重量越大，影響網的震動越明顯。 

七、 分析單個平面網的震動幅度與多個平面網的震動幅度之關係： 

第一張網的震動幅度顯著，而第二張網的震動幅度較微弱。因此我們猜

測第二張網上的蜘蛛較不會搶奪主網上的獵物。 

陸、 結論 

一、 探討校園內的蜘蛛的體長與社會性行為： 

（一） 我們發現，在校園中看到的蜘蛛共織網，肩斑銀腹蛛都有參與織

網，但通常會搭配其他種蜘蛛一起織網，例如一隻肩斑銀腹蛛跟

另一隻熱帶塵蛛一起織的共織網。 

二、 探討不同位置射入獵物，造成單個仿生平面網的震動關係： 

（一） 射入位置在左邊時，左邊質點（質量 D）的震幅會比右邊質點

（質量 B）來得大。 

（二） 射入位置在中間時，左右兩邊質點的振幅相近。 

（三） 射入位置在右邊時，右邊質點（質量 B）的震幅會比左邊質點

（質量 D）來得大。 

三、 探討不同力道射入的獵物，造成單個仿生平面網的震動關係： 

（一） 造成下方質點（質量 C）晃動幅度最大的為 1cm 的力度 

（二） 造成上方質點（質量 E）晃動幅度最大的為 4cm 的力度 

（三） 在我們的模擬實驗當中，力道大小對網的振動影響並不顯著。 
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四、 探討不同大小的獵物，造成單個仿生平面網的震動關係：  

（一） 除了右方質點（質量 B）的震動外，其他四者皆以 0.8g 獵物造成

的晃動最大。 

（二） 在此實驗中，證明重量會影響網的震動幅度。 

五、 探討不同力道射入的獵物，造成多個仿生平面網的震動關係： 

（一） 第一張網中，造成中央質點（質量 A）、下方質點（質量 C）、

上方質點（質量 E）晃動幅度最大的為 4cm 的力度。 

（二） 第二張網中，造成中央質點（質量 A）、下方質點（質量 C）、

上方質點（質量 E）晃動幅度最大的為 3cm 的力度。 

（三） 第二張網中，造成左方質點（質量 B）、右方質點（質量 D）、

晃動幅度最大的為 3cm 的力度。 

（四） 綜合三、和五、的實驗結果，顯示力道對網的震動並無太顯著的

影響。 

六、 探討不同大小的仿生獵物，造成多個仿生平面網的震動關係： 

（一） 第一張網中，除了左方質點（質量 D）、上方質點（質量 E）的

震動外，其他三者皆以 0.8g 獵物造成的晃動最大。 

（二） 第二張網中，造成下方質點（質量 C）、左方質點（質量 D）、

上方質點（質量 E）晃動幅度最大的為 2cm 的獵物。 

（三） 在我們的模擬實驗中，重量會影響網的震動幅度。但第二張網因

為皆只有差距約零點零一，因此不納入實驗考量。 

七、 分析單個平面網的震動幅度與多個平面網的震動幅度之關係： 

（一） 除了 0.4g 4cm 的質量 A 之外，0.1g 4cm、0.2g 4cm、0.8g 1cm、0.8g 

2cm、0.8g 3cm、0.8g 4cm 中的所有質點，第一張網震動幅度皆大

於第二張網的震動幅度。 

（二） 獵物射在第一張網上，因此其震動幅度會大於第二張網。 
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【評語】030310 

優點： 

此研究是以在校園花圃中所發現的肩斑銀腹蛛共織網為發想，來製作

模擬肩斑銀腹蛛網和仿生獵物，並將仿生獵物射向單個和多個仿生網

來進行測試比對，結果顯示力道對仿生網的晃動幅度影響不大，但仿

生獵物的質量會影響晃動幅度。此研究目標明確，引入仿生學的概

念，通過製作模擬肩斑銀腹蛛網和仿生獵物，可以深入分析蜘蛛的共

織網行為，以及不同因素對仿生平面網的晃動幅度的影響。 

建議及檢討： 

1. 震動圖表的呈現讓人能夠一目瞭然地理解震動的情況，然而，數

值計算應該提供公式，而非僅使用 Excel 的數值運算。建議在研

究過程中清楚說明質量 ABCDE 所代表的意義。 

2. 以仿生蜘蛛網進行探討，立意良好，但應強化驗證仿生網的可代

表性(形狀、質地等)。可以圖解的方式說明共生網的組成樣貌，

這將有助於讀者對共生網的理解。 



3. 資料的整理為結果部分的重要項目，而不是將各個實驗結果的原

始數據直接呈現。實驗圖的圖說中圖 4-2-14 到圖 4-7-35 全誤植

成「表」。另外，實驗結果也欠缺資料的彙整以及完整的章節敘述。

圖說應加強 

4. 此研究目標清楚但是研究結果之結論受限，雖然提到不同因素對

仿生平面網的晃動幅度的影響，但並未詳細解釋這些因素之間的

關係或探討其中的機制，應加強論述深度。 
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